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9. ESTIMATION OF ET FROM REMOTE SENSING AND 
METEOROLOGICAL DATA USING THE METHOD 
PROPOSED BY JACKSON 

 
By: Alfredo G. García1, Carlos M. Di Bella 1 and Tomás Hartmann 1 

9.1. Relevance of the application 

The evapotranspiration (ET) is the term used to describe the amount of water, expressed in mm/day, which is 
effectively lost from the earth surface into the atmosphere by soil surface evaporation and plant transpiration. ET is 
an important component of the water cycle and its importance in the hydrological cycle makes necessary its accurate 
quantification both for use in the field of agricultural production and for planning and management of water 
resources. Thus, ET plays a key role in the calculation of the soil water balance, either for the detection of water 
stress conditions, their use as input variable in crop yield models or the study of ecosystem functioning and its 
relationship to local and regional climate, among others. 
The estimation of ET using remote sensing is based on the evaluation of the surface energy balance (Paruelo, 2008). 
These models assume that the ET process uses some of the available energy (net radiation) to vaporize the water. 

The approach uses information derived from remote sensing to estimate surface properties such as albedo, leaf area 
index, vegetation indices, surface roughness, emissivity and surface temperature, and estimate ET as a residual from 
the surface energy balance equation (Gowda et al, 2007): 
 

LE=Rn-G-H      (Eq. 1) 
 

where Rn is net radiation (Wm-2). LE, H and G are the latent heat, sensible and geothermal fluxes (all in Wm-2). LE 
is converted to ET (mmd-1) by dividing it by the latent heat of vaporization (~ 2.45 MJkg-1). 

9.2. Objective of the application 

In order to provide a useful tool in the calculation of water balances for fields of the central region of Argentina, the 
overall objective of this exercise is to provide a procedure for the estimation of evapotranspiration (ET) for clear sky 
conditions, combining information derived from remote sensing in conjunction with meteorological data. 

9.3. Data used 

9.3.1. Local / regional (in-situ) data 

Initial data used to derive the evapotranspiration (ET) are: 
 Land Surface Temperature (LST) derived from MODIS Land Surface Temperature and Emissivity product 

(Land Surface Temperature MOD11A2 product): mod11a2.2009145.LST_Day_1km.tif; 
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 Surface Spectral Reflectances derived from MODIS Surface Reflectances product (Surface Reflectance 
bands 1 and 2 MOD09A1 product): mod09a1.2009145.sur_refl_b01.tif (b01: band 1 - red and b02: band 2 - 
near infrared); 

 Meteorological ground station air temperature data: airtemp.2009145.tif (produced using local ground 
meteorological station data by INTA); 

 Digital elevation model derived from the Shuttle Radar Topography Mission (SRTM); 
 Net radiation: netrad.2009145.tif (produced by INTA following the approach proposed by Kumar et al. 

(1997)). 
Further details on the data used for this exercise are provided in table 9.1.  

Product 
Temporal 

Resolution 

Spatial 

Resolution 
Units Scaling Factor Data Source 

Land Surface 
Temperature 

8 days 1 km Kelvin 0.02 MODIS1 

Surface Reflectance 
(bands 1 and 2) 

8 days 500 m Reflectance 0.0001 MODIS1 

Air Temperature 8days 500 m Celsius - INTA2 

Net Radiation 8 days 500 m MJ.m-2.d-1 - INTA2 

Table 9.1 Data sets characteristics  
 
(1 Warehouse Inventory Search Tool available at https://wist.echo.nasa.gov/api/ and 2 produced at INTA) 

9.3.2. Data from GEONETCast – DevCoCast 

Although the methodology proposed here does not use data from GEONETCast at this moment, INTA plans to 
use products from the GEONETCast – DevCoCast data stream in future versions to derive the ET. It should be 
noted that some of the products do not cover the full geographic extent of the study area. 

9.4. Methodology and description of the study area  

9.4.1. Methodology 

To estimate the ET at regional scale use will be made of the method originally proposed by Jackson et al. (1977), the 
so-called "Simplified Method", which calculates the daily ET (ETd in mmd-1) relating the net radiation received by 
the surface and its temperature difference with the near-surface air, based on the following equation: 
 

ETd=NRd-B(Ts-Ta)n      (Eq. 2) 
 
where NRd (mmd-1) is the daily net radiation, Ts (K) is the surface radiant temperature, Ta (K) is the air temperature 

(near surface), B (mmd-1K-1) and n are parameters that depend on the type and condition of vegetation. 
 
Although it is a relatively simple method, it has been used successfully in estimating the evapotranspiration of 
agricultural crops, reforestations, natural forests and grasslands (Seguin and Itier 1983, Lagouarde and Brunet 1991, 
Courault et al., 1994, Caselles et al., 1998, Nosetto et al., 2005). The ET product will be generated at a spatial 
resolution of 1 km and is having a temporal resolution of 8 days. The overall methodology is presented in figure 9.1. 
Net radiation, which can be separated in net short wave radiation (Sn) and net long wave radiation (Ln) is computed 
using calculations of incoming solar radiation (St) and satellite estimates of land surface albedo (α). The net short 
wave radiation (Sn) is obtained semi-empirically as: 
 

Sn = St (1-α)       (Eq. 3) 
 
where St is the total incoming short wave radiation and α is land surface albedo. 
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Figure 9.1 Flow chart of the proposed ET processing chain  
 

Following Kumar et al. (1997), St is computed as the potential solar radiation received under clear-sky conditions in 
response to latitude and elevation, using a digital elevation model and latitude data, to study the variation in radiation 
for different aspects and slopes. The model takes into account a simplified diffuse radiation. The surface albedo (α) is 
estimated using the reflectance values from bands 1 (620-670 nm), 2 (841-876 nm), 3 (459-479 nm), 4 (545-565 nm), 
5 (1230-1250 nm) and 7 (2105-2155 nm) of the MODIS-TERRA instrument, based on the approach outlined by 
Liang (2000) as: 
 

α = 0.160α1+0.291α2+0.243α3+0.116α4+0.112α5+0.081α7-0.0015  (Eq. 4) 
 
where α(1 to 7) are the reflectance values from the respective MODIS-TERRA bands. 
 
Net long wave radiation (Ln) is estimated empirically according to Granger and Gray (1990). Assuming that 
variations in atmospheric humidity are controlled by the energy supplied to the surface (NR), for clear sky conditions 
and at daily basis, Ln can be estimated from incoming short wave radiation (St) as: 
 

Ln = -4.25-0.24St       (Eq. 5) 
 
Due to the lack of validation for the methodology presented here, INTA is planning to use in the next versions of 
the ET product, data disseminated by GEONETCast (such as Downward Surface Short-wave Flux and Downward 
Surface Long-wave Flux) to estimate the net radiation following the method proposed by LSA-SAF in their 
evapotranspiration product (http://landsaf.meteo.pt). INTA will then compare these approaches and decide to use 
which method is best adjusted in comparison to the ground based meteorological net radiation data. 
The surface radiant temperature (Ts) is obtained from the MODIS Land Surface Temperature and Emissivity 
product, while near surface air temperature (Ta) is derived from a reference height of 1.5 m using the air temperature 
registered by the meteorological ground stations located in the study area. 
The parameter B represents the average bulk conductance for daily-integrated sensible heat flux and n is a correction 
factor for non-neutral static stability (Kalma et al., 2008). While the B value depends on the surface roughness, n 
depends on the atmospheric stability and both coefficients are closely related to the amount of vegetation or 
fractional vegetation cover, which can be estimated from a scaled vegetation index, the Scaled Normalized 
Vegetation Index or NDVI* (Carlson et al., 1995), where: 
 

NDVI* = (NDVI-NDVImin)/(NDVImax-NDVImin)   (Eq. 6) 
 
The Normalized Difference Vegetation Index (NDVI) can also be obtained from the MODIS Vegetation Index 
product. Finally, B and n will be calculated following the equations proposed by Carlson et al. (1995), where: 
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B = 0.0109+0.051(NDVI*)      (Eq. 7) 
n = 1.067-0.372(NDVI*)      (Eq. 8) 

9.4.2. Study Area 

The area of interest (figure 9.2) includes the central portion of the Argentinean territory. This area partly consists of 9 

provincial territories, including Buenos Aires, Entre Ríos, Santa Fe, Córdoba, La Pampa, San Luis, San Juan, La 
Rioja, Rio Negro and Neuquén. From east to west this region presents vast gradients in climate, soils and land use 
types. The main activities of the region are irrigated agriculture and livestock production to the west and rain-fed 
agriculture and livestock production to the east. There are at least two types of climates in this area: temperate humid 
to the east, and semi arid - arid to the west. The mean annual precipitation increases from southwest to northeast, 
ranging between 200 - 1200 mm. The mean annual temperature also increases from southwest to northeast, ranging 
between 14 - 20 ºC. 

 
Figure 9.2 Study area located at the central region of Argentinean territory. Triangles show the location of 

meteorological ground station used to estimate ET 

9.5. Data pre-processing 

9.5.1. Satellite Remote Sensing data 

As mentioned above, the surface temperature (Ts) in the ET equation, the NDVI (needed to calculate the B and n 
coefficients) and the surface spectral reflectance values (needed to compute the albedo in the net radiation estimate) 
are obtained from the Moderate Resolution Imaging Spectroradiometer (MODIS-TERRA) products. Specifically, use 
is made of the Surface Spectral Reflectance 8-day L3 Global 500m (MOD9A1) and Land Surface 
Temperature/Emissivity 8-day L3 Global 1km (MOD11A2) products. Two tiles are used to cover the entire study 
area: h12v12 and h12v13. The images – products have been obtained from the MODIS receiving station located at 
INTA (Buenos Aires, Argentina). The Land Surface Temperature from MOD011A2 needs to be resampled to 500 m 
spatial resolution in order to obtain the same spatial resolution as the MOD09A1 product. First the necessary import 
and pre-processing has to be conducted before the ET can be derived. Copy the zipped exercise data file on your c:\ 
drive. Unzip the file chapter9.zip. On your C:\ drive you now should have a directory called “chapter9” containing 
the following sub directories: ‘DataInput’ and ‘Working_Dir’. The folder DataInput is containing the following sub 
directories: ‘1_SufraceTemp’, ‘2_SurfaceReflect’, ‘3_AirTemp’ and ‘4_NetRad’. Open ILWIS and use the ILWIS 
navigator to browse to the active working directory for this exercise, which is “C:\Chapter9\Working_Dir”. In the 
ILWIS Catalog you find a table, double click the table to open it, look at the content and close the table. Close 
ILWIS and once more open ILWIS. ILWIS should open in your active working directory 
“C:\Chapter9\Working_Dir”.   
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9.5.1.1. Import and scale MODIS LST product 

To import all necessary MODIS Land Surface Temperature (mod11a2*.tif) data in order to estimate ET for a long 
time period using the ILWIS menu can be cumbersome. Use Windows Explorer to check the content of the sub 
directory: “C:\chapter9\DataInput\1_SurfaceTemp”. There are 4 files. The file “SurfaceTemp.rar” contains the 
original Land Surface Temperature images in TIF format for 4 consecutive dates. In order to import these images 
there are two batch files, “multi_import_SurfaceTemp_start.bat” and “multi_import_SurfaceTemp.bat”, respectively. 
The content of these batch files is also provided in figure 9.3 and 9.4. Right click with the mouse the file 
“multi_import_SurfaceTemp_start.bat”, select “Edit” from the context sensitive menu to examine the file content.  

Figure 9.3 Batch file 1 to start the multi temporal import routine 
 

This batch routine states in the first line that it has to create a new batch file, called “import_param.bat” specifying 
the location of your ILWIS directory. The second line adds another line to the batch file “import_param.bat”, 
specifying the location of the directory where you have unzipped the exercise data. Line 3 specifies that the content 
of the “SurfaceTemp.rar” file should be extracted and the content should be written in the same directory. The last 
line indicates that for all (now decompressed) images containing the string “mod11a2*.tif” another instance of a 
batch file, called “multi_import_SurfaceTemp.bat” should be executed. The listing of this batch file is provided 
below. 

Figure 9.4 Batch file 2 for importing the Land Surface Temperature data 
 
This batch routine, which is executed after all data is decompressed, starts with a ‘set’ command. The file is passed to 
the second batch by its file name, here addressed as %1. Two portions of the filename string are being use, namely 
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the filename without the extension (‘shortfilename1’) and the date of the product (‘shortfilename2’). Next command 
is calling the batch file “import_param.bat” that has been created during execution of the first batch file, defining the 
locations of the “IlwisDir” and “ChapterDir”. The next line is executing the ‘gdal_translate.exe’ utility, taking the *.tif 

image and writing the output file in ILWIS format in the same directory. Next command is scaling and converting 
the previously imported map and is applying a scaling factor (0.02) and offset, here a value of ‘273.15’ is used to 
convert from Kelvin to Celsius, respectively. Also note that the final converted image in ILWIS format will be 
located in the “Working_Dir (in this case C:\Chapter9\Working_Dir). 
Now activate from Windows the ‘Start’ menu and select ‘Run’. You are going to use the Windows ‘command.exe’ 
utility to run the batch files. In the new command window that appears navigate to your active working directory (in 
this case ‘C:\chapter9\DataInput\1_SurfaceTemp’) and execute the Land Surface Temperature import batch file. 
For commands to navigate to your working directory and other DOS command syntax, see also figure 9.5. 

Figure 9.5 Starting the batch processing from a CMD window 
Note that on the command line the batch file “multi_import_SurfaceTemp_start.bat” will be executed using two 
parameters. The first parameter specified is “C:\Ilwis”. This parameter is the location of your ILWIS directory; in 
your case this might be different as you might have installed ILWIS using a different folder. In that case specify the 
appropriate folder. The second parameter is “c:\chapter9”; this is the location of your exercise data directory. If you 
have installed the exercise data as described before you don’t need to change it over here, else specify the appropriate 
folder. After the correct string has been typed on the command line press “enter” from the keyboard to execute this 
batch process. 
When the import has finished select from the main ILWIS menu the option “Window => Refresh” and you will 
note that four surface temperature maps have been created, using as time stamp “year” and “Julian day”. Double 
click one of the maps, e.g. “SurfaceTemp_2009145”, use as Representation “Pseudo” and press “OK” to display the 
map. Note the map values by moving the mouse over the active map window, keeping the left mouse button pressed. 
Display also another surface temperature map.  

9.5.1.2. Import and scale MODIS Surface Reflectance product 

To import all necessary MODIS Surface Reflectance images (mod09a1*.tif) repeat the procedure described above 
and now use the data from the sub directory ‘C:\chapter9\DataInput\2_SurfaceReflect’. Note that in this case the 
command line should be specified as “multi_import_SurfaceReflect_start.bat c:\ilwis c:\chapter9”. The 
“multi_import_SurfaceReflect.bat” batch file is importing the TIF file into ILWIS format and subsequently is scaling 
the reflectance values by a scale factor of 0.0001 (see also Table 9.1 and Figure 9.6). 
When the import has finished select from the main ILWIS menu the option “Window => Refresh” and you will 

note that four mod09a12009***_b01 and mod09a12009***_b02 maps (*** = Julian day) have been created. Double 
click one of the maps, e.g. “mod09a12009145_b01”, use as Representation “Pseudo” and press “OK” to display the 
map. Note the map values by moving the mouse over the active map window, keeping the left mouse button pressed. 
Display also the band 2 image of the corresponding time: “mod09a12009145_b02”.  
 



APPLICATION MANUAL 

113 

Figure 9.6 Batch file 2 for importing the Surface Reflectance data 

9.5.2. Meteorological Data 

9.5.2.1. Import of the INTA air temperature product 

Use is made of air temperature recordings from 100 meteorological ground stations located in the study area, 
recorded at a reference height of 1.5 m. The air temperature at daily temporal resolution is averaging for each 8-days 
period. This information is interpolated covering the full extent of the study area in order to obtain air temperature 
data at the same spatial resolution as the variables derived from remote sensing (1 km).  

 
To import all necessary INTA Air Temperature images (airtemp*.tif) repeat the procedure described above for the 

MODIS products and now use the data from the sub directory ‘C:\chapter9\DataInput\3_AirTemp’. Note that in 
this case the command line should be specified as “multi_import_AirTemp_start.bat c:\ilwis c:\chapter9”. In this 
case the batch routine “multi_import_AirTemp.bat” is only converting the images from TIF to ILWIS format (see 
Figure 9.7). 
When the import has finished select from the main ILWIS menu the option “Window => Refresh” and you will 
note that four air temperature maps have been created, using as time stamp “year” and “Julian day”. Double click 
one of the maps, e.g. “airtemp_2009145”, use as Representation “Pseudo” and press “OK” to display the map. Note 
the map values by moving the mouse over the active map window, keeping the left mouse button pressed. Display 
also another air temperature map.  
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Figure 9.7 Batch file 2 for importing the Air Temperature data 

9.5.2.2. Import of the INTA Net Radiation product 

To import all necessary INTA Net Radiation images (netrad*.tif) repeat the procedure described above for the 
MODIS products and now use the data from the sub directory ‘C:\chapter9\DataInput\4_NetRad’. The last 
command in the ‘multi_import_NetRad.bat’ batch file is also replacing the -999.9 pixel values by a no data value, 
called undefined, in  ILWIS, represented by  “?”. The replace is done using an IFF function (see Figure 9.8). 

Figure 9.8 Batch file 2 for importing the Net Radiation data 
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When the import has finished select from the main ILWIS menu the option “Window => Refresh” and you will 
note that four netrad maps have been created, using as time stamp “year” and “Julian day”. Double click one of the 
maps, e.g. “netrad_2009145”, use as Representation “Pseudo” and press “OK” to display the map. Note the map 

values by moving the mouse over the active map window, keeping the left mouse button pressed. Display also 
another air temperature map.  

9.5.2.3. Resampling the LST product 

After import of all Land Surface Temperature maps to ILWIS format you need to resample these images to 500 m in 
order to obtain the same spatial resolution as the other products. To do this type the following expressions in the 
command line from the main ILWIS menu (note that you can use the command line history from the main ILWIS 
menu to quickly change the date string portions which change within each resampling procedure): 
 

Surfacetemp_2009145r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_ 
2009145,airtemp_2009145.grf,nearest) 
 
Surfacetemp_2009153r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_ 
2009153,airtemp_2009145.grf,nearest) 
 

Surfacetemp_2009161r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_ 
2009161,airtemp_2009145.grf,nearest) 
 
Surfacetemp_2009169r.mpr{dom=VALUE.dom;vr=-100.00:100.00:0.01}:=MapResample(SurfaceTemp_ 
2009169,airtemp_2009145.grf,nearest) 

 
When the resampling of the LST maps has finished, double click one of the maps, e.g. “surfacetemp_2009145r”, use 
as Representation “Pseudo” and press “OK” to display the map. Note the map values by moving the mouse over the 
active map window, keeping the left mouse button pressed. Display also another resampled land surface temperature 
map.  

9.6. Computation of the ET 

9.6.1. Compute Normalized Difference Vegetation Index (NDVI) 

Compute the NDVI using the reflectance values of the red (b01) and near infrared bands (b02) obtained from the 
MODIS Surface Reflectance product. To do this select from the main ILWIS menu the options “Operations => 
Raster Operations => Map Calculation”. Type the indicated algorithm as show the Figure 9.9 in the ‘Expression’ 
window, specify an output map name (in this case “ndvi_2009145”), select as Domain “Value”, specify as Value 
Range: “0” and “1” and set the Precision to  “0.001”. Execute the command by pressing ‘Show’. Display the map 
“ndvi_2009145” calculated, use as Representation ‘NDVI1’. 
Repeat the same procedure to compute the NDVI for the other dates: 153, 161 and 169. For efficient processing it is 
advised to make use of the command line history available from the main ILWIS menu. Change the Julian day string 
portions of the equation and press enter to execute the command and calculate a new ndvi map. You can of course 
keep using the menu option. 
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Figure 9.9 Map calculation window to compute the NDVI 

9.6.2. Create Map Lists 

To compute the ET for different time stamps it is more convenient to create maplists. In order to deal with the same 
operation over all time stamps within a maplist, you have to create a map list for each of the imported and resampled 

products (surfacetemp_resampled, ndvi, airtemp and netrad). To create a map list select from the main ILWIS menu 
the option “File => Create => Map List”. Select the list of layers in the appropriate order to be included in the map 
list, press the “>” button to move the maps to the right hand listing, specify an output Map List name, here “ndvi” is 
used and execute the command by pressing “OK” (Figure 9.10). Repeat the same procedure to create a Map List for 
each data input, here “surftempr”, “airtemp” and “netrad” is being used. 

Figure 9.10 Create Map List window 

9.6.3. Compute Scaled Normalized Difference Vegetation Index (SNDVI) 

To compute SNDVI from the ‘ndvi’ map list, select from the main ILWIS menu the option “Operations =>Raster 
Operations => Map List Calculation”. Type the algorithm as indicated in Figure 9.11: (@1-
MAPMIN(@1))/(MAPMAX(@1)-MAPMIN(@1)). Specify an output Map List name (in this case “sndvi”) and 
execute the command by pressing ‘Show’. 

When the calculations of the scaled NDVI maplist has finished, double click one of the maps, e.g. “sndvi_1”, use as 
Representation “NDVI1” and press “OK” to display the map. Note the map values by moving the mouse over the 
active map window, keeping the left mouse button pressed. Display also another sndvi map. Note also that the map 
layer sndvi_1 represents Julian day 145, etc.! 
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Figure 9.11 Map List calculation window to compute the SNDVI 

9.6.4. Compute B and n 

To compute B from the ‘sndvi’ map list, select from the main ILWIS menu the option “Operations => Raster 
Operations => Map List Calculation”. Type the algorithm as indicated in Figure 9.12 (left): 0.0109+(0.051*@1). 
Specify an output Map List name (in this case “B”) and execute the command by pressing ‘Show’. Repeat the same 
procedure to compute “n”, but now apply the following formula as given in figure 9.12 (right): 1.067-(0.372*@1). 
Check the results obtained, using as Representation “Pseudo”. 

Figure 9.12 Map List calculation window to Compute B (left) and n (right) 

9.6.5. Compute temperature differences 

Follow the same procedure as used above to compute the difference between the resampled Surface Temperature 
maplist (“surftempr”) and Air Temperature maplist (“airtemp”). Apply the following formula (figure 9.13): @1-@2. 
Select from the main ILWIS menu the option “Operations =>Raster Operations =>Map List Calculation”. Type the 
algorithm as indicated in Figure 9.13, use now two Input MapLists. For Maplist 1, select “surftempr” and as maplist 
2 select “airtemp”. Specify an output MapList name (in this case “diftemp”) and execute the command by pressing 
‘Show’. Check the results obtained, using as Representation “Pseudo”. 
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Figure 9.13 Map List calculation window to compute temperature differences 

9.6.6. Compute ET 

Using the Map List calculator apply the following formula to compute evapotranspiration in mm.d-1 (figure 9.14): 
(@1*0.408)-(@2*(POW(@3,@4))). Note that for the net radiation values a transformation factor is applied (the 
reverse of vaporization latent heat) to convert from MJ.m-2.d-1 to mm.d-1. 

Figure 9.14 Map List calculation window to compute the ET 
 
Check the results obtained, using as Representation “Pseudo”. These should resemble for Julian day 153, or map 
layer “ET_2” of your time series “ET”, the map as presented in figure 9.15. From the active map window, select the 
option “Layers => Add Layer”, browse to your ILWIS directory, select the sub directory “Extensions\Geonetcast-
Toolbox\util\maps” and select as vector layer “country_02”, uncheck the option “Info” and activate the option 
“Boundary Only” and press “OK”. Don’t close the map window. 

9.7. Checking the ET results 

Validation of the actual ET is a difficult matter. To at least assess whether the results make some sense the potential 
evapotranspiration (PET) for each meteorological station following the Penman and Thornthwaite methodology 
have been computed. For this purpose, use was made of daily data of air temperature, wind speed at a reference 
height of 2 m., relative humidity and effective heliophany. The maximum daily PET value for each identical 8-days 
period was calculated and this can now be compared with the remote sensing derived ET estimations. 
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Figure 9.15 Resulting ET map for Julian day 153 of 2009 
 
Open once more the table “etp_153” and check the content. You will note that there are sometimes remarkable 
differences between the two PET approaches used. In this case only those stations where the PET is similar will be 
used.  
Type the following equation in the table command line: finalPet:=iff(mean_ETP_Penman-

mean_ETP_Thornthwaite<0.5,mean_ETP_Penman,?). Press enter to execute the operation and accept the defaults, 
press “OK” once more. A new column is created and the values of this column will be crossed with the estimated 
ET for Julian day 153, or ET_2 from your map list. Close the table. 
Convert the table to a point map. To do so right click with the mouse the table “etp_153”, select from the context 
sensitive menu the options “Table Operations => Table to Point Map”, as Coordinate System select 
“airtemp_2009145” and as output Point Map specify “etp_153”. Press “Show” to execute the operation. Look at the 
point map created and close the map. From the active map window used to display the map “ET_2 select the option 
“Layers=> Add Layer”, browse to your ILWIS directory, select the point map “etp_153” and activate from the 
Display Options menu the check box “Attribute”, select the column “finalPET” and press “OK”. From the active 
map window, select “File => Open Pixel Information”, move the mouse cursor over the points on the map and 
check the results from the pixel information table. Close the active map layer. 
Convert the point map “etp_153” to Raster. Right click with the mouse the point map “etp_153”, select from the 
context sensitive menu the options “Rasterize => Point to Raster”, as Georeference select “airtemp_2009145” and 
as output Raster Map specify “etp_153”. Press “Show” to execute the operation. You might need to zoom in to the 
new raster map created to see the results! 

From the main ILWIS menu, select the options “Operations => Raster Operations => Cross”, as first map specify 
“ET_2”, as second map select the attribute column “finalPet”. To do so, click on the “+” sign in front of the raster 
map “etp_153” to select the appropriate column. As Output Table specify “compareETp_Eta and press “Show”. 
From the menu of the newly created cross table select the Graph icon, as X-Axis specify map2 (note that this is the 
resulting value of the attribute table, representing the potential ET according to Penman), and as Y-Axis select 
“ET_2”and press “OK”. Double click in the left hand legend of the graph the X-Axis and specify as Min-Max range 
“0” to “2”, Interval of “0.5” and press “OK”. Do this also for the left hand Y-Axis. Uncheck the Legend option. 
Double click the attribute “map2 * ET_2” and change the Color from Transparent to “Red”. Your results should 
resemble those presented in figure 9.16. 
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Figure 9.16 Comparing estimated ET for Julian day 153 with PET 
 

9.8. Conclusions 

From figure 9.16 it is clear that the computed ET is less than the potential ET which is according to expectation. In 
order to validate the ET estimates based on remote sensing, INTA will use more detailed ET data derived from eddy 
covariance based towers measurement and estimates based on meteorological ground station data. INTA at this 
moment has access to ET measurements from four eddy covariance flux towers located in representative dominant 
land use types in the study area (forest, agriculture, commercial tree plantations and dry forest). 
In conjunction to this the near future additional information can be used from 150 meteorological stations that are 
currently being installing all around the Argentinean territory by INTA. 
To account for possible errors on input variables (NR, B, n and Ts-Ta), INTA will test the ET estimates sensitivity by 
exploring the effects of extreme values of these variables. 
Acknowledging the uncertainties in the air temperature due to the interpolation from low density of meteorological 
ground stations, INTA will furthermore explore the possibility of using the air temperature data derive from the 
MODIS atmospheric profile product. 
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